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Creating Steel Fabrication Friendly Families and
Schedules with Autodesk® Revit® Structure

Tina Bos — Herold Engineering Limited

SE3048-L  Once you have mastered the day-to-day use of Autodesk Revit Structure, you must
continue to push the boundaries toward enhanced integration for construction purposes. One of the most
commonly used materials in a structural engineer’s arsenal is structural steel. In this hands-on lab, we
focus on using the information contained within Revit and the information we can derive from within
custom family content to create enhanced structural steel schedules. This class is about the use of
shared parameters and custom families to facilitate greater symmetry with steel fabricators through the
use of smarter families and schedules.

Learning Objectives
At the end of this class, you will be able to:

»  Use shared parameters to make smarter families and schedules

« Create a parametric steel plate family and detailed geometrical schedule
« Use parameters and calculated values for steel quantity takeoffs

* Create a steel takeoff schedule

About the Speaker
Tina is a Senior Structural Technologist and the BIM Leader for Herold Engineering in Victoria,
BC. Tina is a lead Revit Structure modeler, producing construction documents in Revit since
2006. Tina creates and maintains all Revit standards and content as well as providing on-
going internal Revit training. She is responsible for the development of long term goals and
strategies for the structural discipline and the overall BIM planning for the company. Tina is
also chair of the BIMbc Victoria Revit Users Group.
tbos@heroldengineering.com or tina@bimbc.com




Creating Steel Fabrication Friendly Families and Schedules with Autodesk® Revit® Structure

Section 1: Create a Steel Base Plate Family

In this section you will create a rectangular steel base plate family complete with shared

parameters.

1. Open Autodesk® Revit® 2014 and open the file SE3048-L Family Testing Project in the
session folder C:\DataSets\ Tuesday\SE3048-L.

2. Start a new Structural Column Family using the default imperial family template.

E Spot Lighting Fixture.rft

E Structural Column.rft

E Structural Foundation.rft

E Structural Framing - Beams and Braces.rft
E Structural Framing - Complex and Trusses.rft

-
ol E Creates a Revit file.
D New » E Project
Creates a Revit project file.
Family
E SE=l D Dlﬂ Creates a set of custom components to
use in projects.

@ Structural Stiffener Line Based.rft
@ Structural Stiffener.rft

TIP: Use the structural column family template instead of the generic model face based
template for your custom base plate family. This will allow easier placement of the base
plate to the column, priority graphical representation in the plans, and each base plate will
also appear and can be tagged within the graphical column schedule.

NOTE: If using the metric structural column family template, this template
includes Depth and Width parameters and related dimensions that need to be
deleted prior to beginning this exercise.
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4. From the Manage Tab, select Shared Parameters

B

=
Shared
Parameters

Save the new family as BasePlate_4bolt.rfa to C:Datasets|Tuesday|SE3048-L

Load the file SE3048-L.txt in the session folder C:\DataSets\ Tuesday\SE3048-L

TIP: Use a discipline prefix descriptor for parameter
groups within a multi-discipline shared parameter file.

In the Shared Parameters dialog box, create a new Group named S-Base Plate

6. The following parameters have been created within the group S-Base Plate:
*Note: Use your company abbreviation where hel* is indicated.

Name

b_hel*

h_hel*
b_hole spacing
h_hole spacing
hole_diameter
plate_thickness
anchor_embed
anchor_count

anchor_type

plate_type

Discipline
Common
Common
Common
Common
Common
Common
Common
Common
Common

Common

Type of Parameter
Length

Length
Length
Length
Length
Length
Length
Text
Text
Text

Edit Srared Parmeters

Shered peramatar Tka:

LA OLSERHE-L. bt Broess. Creals...
Parsrmster greup:
5 Boer Mol r
Farormin s
T
erchor_srmbad i
prchor_type
b_h Propertes...
b_hals spacing
b
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plane_tppe
......
e
MEram..
Drebe
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7. Select the Center (Left/Right) reference plane and check: Defines Origin.
this for the Center (Front/ Back) reference plane.
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NOTE: While the Defines Origin is not required to constrain the geometry of the
symmetrical base plate family we are about to create, it is necessary when creating base
plates which are not symmetrical. This base plate family can be used as a template for
further base plate configurations and in order for the base plate to show up in identical
locations with the columns in the graphical column schedule all offset base plates must be
created such that their origin point is center of column.

For further on this see the NOTES section on Graphical Column Schedules.

8. Add dimensions to the right and left, back and front reference planes already within the
base family. This first set of dimensions will be equality constrained dimensions. To
create equality constraints click the first reference plane, the center plane, then the
opposite side all in one operation of the dimension command. Then Select the right /
left dimension and under label choose Add Parameter.

L biore =

- I

9. Select Shared Parameter, and Select b_hel from the Shared Parameter list.
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Within the Parameter Properties box you can now choose whether the parameter will
be a type or instance property, and where you’d like the parameter grouped.

The width parameter, b_hel will be a type parameter and located within the dimensions
grouping in Type Properties dialogue box.

b_hel =2'-0"

Faramater Typ= :
Fomily parameter EQ EQ

(Cennat sppeer In schadules or tegs])

& Shered parameter

I
I
|
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I
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10. Repeat Step 9 and add the length parameter, h_hel to the family.

11. Flex the family.
From the Properties Panel, select Family Types. In the family types dialogue box change
the h_hel and b_hel values and confirm that the reference planes move accordingly.

Famiy Typas
Parameter | I

| Materials and Finishes
_Shnl:mra baterial idefait
| oam
h_hel |q|j—|
| b_pe ECH -
| tdentity Data

Hew,

h_hel = £ - 0"

Lookup Tables

= h = < J L 4 L Help




Creating Steel Fabrication Friendly Families and Schedules with Autodesk® Revit® Structure

12. Select the Create Tab, choose the Forms Panel - Extrusion

In sketch mode, draw a rectangle.

Align and lock the sides of the rectangle to the right, left, back and front reference

planes. Then select Finish Edit Mode.

13. Flex the family.

From the Properties Panel, select Family Types. In the family types dialogue box change
the h_hel and b_hel values and confirm that the extrusion moves accordingly.

| b_hel=4'-0" |

‘ EQ EQ ‘

B | Farnily Types.
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Family Types
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Newn,,
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EQ

h_hel=&'-0"

EQ

and Finishes.
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14. Open the Front Elevation. Add a reference plane above and parallel to the Lower Ref
Level. Name the reference plane: Top of Base Plate. Add a dimension from the Lower
Ref Level to the Top of Base Plate reference plane. As per step 9, label and add the
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shared parameter plate_thickness as a type parameter grouped under dimensions to
this dimension.

I I I
. . __ 1 __  _ UpperRef. Level
T g-0
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15. Flex the family.

From the Properties Panel, select Family Types. In the family types dialogue box change
the plate_thickness value and confirm that the reference plane moves accordingly.

16. Align and lock the top of the extrusion to the Top of Base Plate reference plane.

17. Flex the family.
From the Properties Panel, select Family Types. In the family types dialogue box change
the plate_thickness value and confirm that the extrusion moves accordingly.

18. Create a Base Plate Type.
In the family type dialogue box create at least one default plate type. Additional types
will be created on a project by project basis.
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19. Test the family.
Load the Base Plate family into the SE3048-L Family Testing Project (this is the out of
the box Structural Analysis Template saved as a project) and check all the type
properties for the desired results.

TIP: Test all your families and any downloaded content within a family testing
project created from your company template before loading it into any project.

Open the Level 1 plan view and place a base plate. Note that the Top Level and Offset
parameters are redundant because the extrusion is locked to the Top of Base Plate
reference plane and the plate_thickness parameter is used to control the extrusion for
each type. Elevation of the base plate is controlled by the Base Level and Base Offset
parameters.

- Level1 g
* OI _ OII \\’

0'-

Note: the alignment of the plate in elevation. The extrusion extends up from the Base
Level elevation. This is my preference and you can adjust the extrusion settings to suit
your work flow standards.
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Section 2: Adding Bolt Holes to the Steel Base Plate Family

At this point you can continue to work with your Base Plate family or open the
dataset family: SE3048-L BasePlate 2.rfa

1. From the Create Tab, choose Datum Panel, select Reference Plane
* Add four references planes that will serve as bolt hole origin points.
* Add the b_hole spacing and h_hole spacing shared parameters. As before,
these will both be type parameters grouped under the Dimensions.
* Add two more aligned dimension strings with equality constraints to the
hole spacing dimensions about the centerline of the plate.
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b_hel=1'-6"

I I
I I
I I =
I I o
| L R T L n
| | o | | =
| | o wml - et Hl n
-~ 0~ - T--~° T T T T T T T T T ! | ! 8 E’
T 4 L I e PR A
5 G - B it Bt Bl el L I I 13
| w Lo j [ D ——— TR w ®
? | | | | @
(ﬁl it ol Bl i e el e i - = D S
— L i T Tt - |
[} 1 by <
< |
| [
Lo N I [
| |
|
|
I

b_hole s?acing =0"-10"
2. Flex the family.
From the Properties Panel, choose Family Types. In the family types dialogue box

change the h_hole spacing and b_hole spacing values and confirm that the reference
plane moves accordingly.
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plate_thickness
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3. From the Create Tab, choose the Forms Panel, select Void Forms, then Void
Extrusion
* Check the void extrusion setting on the option bar. In this case, change the
depth to 1” to match our current plate thickness.

Creat=  Insert  Annoiate  View B Add-lns  HEL_Addins Ewiensions | Mooy | Creste Vaid Extrusion ]~
b |2 AL o B &R o = () X Zad
Modify || [IE | . . Om =+ 0o 0Ol F Ot .
- H‘J - e O [ e v oo
Select = Froperties Cliphoars T ey Modiry Mieasure | Cregte | Mode D
EH@g-S-@- =S L0 A B GE
Depth 1 ¥ ¢ Chain Offse; O 07 R [ b
* Add four 1” diameter circles at the intersection of the hole spacing reference
planes.

e Add a diameter dimension to each circle and constrain it with the
hole_diameter shared parameter.
e Finish Edit Mode.
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4. Open the Front Elevation.
* Change the plate_thickness value to 3” for easier visibility.
» Align and lock the void extrusion to the Top of Base Plate Reference Plane
* Change the plate_thickness back to 1” confirming the void extrusion is
behaving properly.

T P Lower Ref. Level

Ol _ Oll
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5. Flex the family.

From the Properties Panel, choose Family Types. In the family types dialogue box
change the h_hole spacing, b_hole spacing, and hole_diameter values and confirm that
the void move and change size accordingly.

Finishing Touches - Visibility, Material and Shared Parameters

At this point you can continue to work with your Base Plate family or
open the dataset family: SE3048-L BasePlate 3.rfa

1. Visibility:
* Select the Base Plate Extrusion and choose Visibility Settings
e The Base Plate is currently set to be visible in all views at all detail levels.
This is my preference. You can alter the visibility levels and add symbolic
lines to suit your company standards.

T Farmip By sisia lrS-".!-'\ﬂ-- it

e Select the Manage Tab and choose Object Styles and create a new
Subcategory named Base Plate.

Dbjact Syien

11
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2.

e Select the Manage Tab and choose Object Styles and create a new
Subcategory named Base Plate. You can then set Object styles to control
visibility of the base plate within the family and with your projects.

Object Styles

Model Objects | Annotation Objects | Imported Objects

5

Category Projelglt?c?nwelgtgut Line Color Line Pattern Material
= Structural Columns 1 4 M Black Solid
2% Base Plate 1 1 ek Salid
~-Hidden Lines 1 1 M Black Dash
Rigid Links 5 5 M RGB 000-127-
- Stick Symbals 6 6 M Black Solid

* Once the Subcategory is created it must be assigned to the base plate. Select
the base plate and choose the Subcategory pull down. Set it to Base Plate.
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Material: There are a half dozen default materials in the structural column family
template. Add a steel material to the Base Plate family.

e From the Manage Tab, select Transfer Project Standards

e Transfer Standards from the SE3048-L Family Testing Project
* Check none then Select only Materials to transfer into the Base Plate Family
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* Open the Family Types dialogue box

» Select Material and choose Steel ASTM A36 from the list of materials now
contained in the Material browser.
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NOTE: Ideally we would transfer project standards from the company
template to maintain consistent standards. In lieu of transferring project
standards for the material however, you can also create your own material by
duplicating and editing one from the family template.

3. Shared Parameters: There are a few more shared utility type parameters to add to
the family for the purposes of the schedule we will build in the next section.

TIP: Adding non-geometrical shared parameters to a family means these parameters
are specific to the base plate family. In this case, because we’ve used a structural
column as the family template, adding the shared parameters to the schedule within our
project would also assign them globally to all structural columns in a project.

4. Open the Family Types dialogue box and add the following shared parameters as
Type parameters and Group under Structural.
anchor_embed
anchor_count
anchor_type
plate_type

NOTE: In this case these shared parameters are not dimensions and should therefore be
grouped in another category to suit your company standards. For consistency, | typically
choose to group all company custom parameters under Structural for the ease of the users.
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Section 3: Create a Steel Base Plate Schedule

Assign default text values to the newly added shared parameters. These
values will then remain constant until changed for each new type of base
plate created. If left blank, you would need to input these 3 values with each
new type created, using this method you need only edit the anchor_embed
parameter if necessary to change the default type.

Hame: -0 k16" % 17

Paramater Value

[

Foamula

,

Materials and Finishes
Structural Matevial (defaul Steel ASTM A5

Structural
plate_type RECT

achar_typs THREADED ROD
anchor_embed N
anchar_count q

Dimensions

plate_thickness o

kol _diameter o

F_hiode spading 1

Fi_hel
_hale spacing s
B_hed 1

Identity Data

b e | e e |

o | |

Parameters

Add

Loskup Tabkes

Hasags,..

1. Open the project SE3048-L Base Plate Schedule Project.

2. From the View Tab, choose Schedules, and select Schedule/Quantities

Select Structural Columns

Name the schedule: Base Plate Schedule

3. The Schedule Properties Dialogue box will open to the Fields tab, add the following
parameters to the schedule:

Type Mark
b_hel

h_hel
plate_thickness
b_hole spacing
h-hole spacing
hole diameter

anchor_type
anchor_embed
anchor_count
Type Comments
Count

Volume

14
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4. Add a Calculated Value named: volume_calc and add the following:

e Discipline: Common
e Type: Volume

e Formula: b_hel*h_hel*plate_thickness
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5. Add a Calculated Value named: weight_calc
and add the following:

Discipline: Structural

Type: Mass

Formula:
volume_calc*489.99168Ibm/ft?

6. Add a Calculated Value named:
total_weight _calc and add the following:

Discipline: Structural
Type: Mass
Formula: weight_calc

NOTE: The out of the box Volume
parameter is a net volume value
(revit will deduct the voids from the
total plate volume). The
volume_calc we have just added is
a gross volume.

TIP: Select the E] pickbox to add

already scheduled parameters to the
Formula instead of typing them in.
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Schedule Properties —
| Fields | Fitsr | SardingiGrouping | Farmaiting | Appearance
7. Select the Filter Tab and set the first filter to: Pt [Tape ek =] [sntans
e Type Mark =
* contains o [fpcne) =l
* BP

8. Select the Sorting/Grouping Tab and set the first sort filter to

* Type Mark
e Ascending

e Uncheck Itemize every Instance
*  Check Grand totals and Select Totals only from the pull-down
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9. Select the Formatting Tab, Select all Fi
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Note: You may wish to select “Count and

totals” which will give you a total count of the

base plates and their combined weights.

However the count total aligns to the far left o

the schedule far away from the count
parameter and seemingly unrelated to the

=h

count parameter further along in the schedule.

BPZ  0-10" | 1-64
BP4 0-10" | 1'-a'r[
BFS  0-10" | 1-4"
: )
S R

-

elds and set the alignment to Center
Schathle Peoprties |

o g Fameing

Fald feemaing:

sk M

| M ot Foarvd e i

| Fukdn | Fiter | SortngyGrouping Fermamng | sppeanasce

gt Futee:

bl It _paisght

plate_hictnsss

b el s E—

hols_darmsr |Harsatsl -

archar_typs

archar_srmbad AbgrTEnt

erchar_poant

Typs Camrrants e =

Count

[ Fraid et Fordd Format...

1o o . rr—r——
Todd Fa .

e onaiadan gl funived a ddwels

10. Select the weight_calc and check Calculate totals.
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Section 4: Create a Steel Base Plate Check Schedule

At this point you can continue to work in your Base Plate Schedule Project
or open SE3048-L Base Plate Schedule Project 2 dataset.

1. Select the Base Plate Schedule from the project browser and duplicate the view.
2. Rename the duplicated Base Plate Schedule: Base Plate Schedule - Check.
3. Open the Schedule Properties dialogue box to the Fields tab

4. Add the Calculated Value: b_edge distance_calc
* Discipline: Common
e Type: Length
e Formula: (b_hel - b_hole spacing)/2
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e Discipline: Common i e — o e
« Type: Length e e
*  Formula: (h_hel - h_hole spacing)/2 e st rson: .
H| |Sriner s pro—
i;”&;?.:;..f Ln =
6. Navigate to the Formatting Tab s R fomasig: P o
* Select the b_edge distance_calc 7] v i st s
L. . Conditiceal Formatting —— o
* Select Conditional Formatting .
* Set Test: Less Than T e e
i Vallle.' 0"1 1/2" Condhtians by Lse; Background Color: .
b_sdga dstance_cae < 0' - 11/3° - e Al

*  Background Color: Red |
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7. Repeat the same steps for the h_edge distance_calc
8. Note that the BP2 has flagged an error for the b_hole distance_calc.

9. Return to the Base Plate Schedule and Cleanup / Format for Sheet Placement
* Schedule Properties box, Formatting, select the Volume and volume_calc
fields and make them Hidden
* Revise all the Column Title names
e Apply your company template to the schedule

Section 5: Create a Steel Beam Schedule

At this point you can continue to work in your Base Plate Schedule Project or open
SE3048-L Base Plate Schedule Project 3 dataset.

1. From the View Tab, choose Schedules, select Schedule/Quantities

e Select Structural Framing
* Name the schedule: STEEL BEAM TAKEOFF SCHEDULE

2. The Schedule Properties Dialogue box will open to the Fields tab, add the following
parameters to the schedule:

* Type

* Reference Level
* Count

e Length

LI 4

3. Add a Calculated Value named: weight_calc and

add the following:
e Discipline: Structural
* Type: Mass b IH
«  Formula: (W *1 Ib/ft) * Length e . . —

Tk sherras i bk ad e

NOTE: The W parameter selected
above has an “other” designation
within the OOTB family. So we
assign units by multiplying by 1 Ib/ft.
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Sohedule Froperes DL (N TREOPT EOSEDRLD

4. Select the Sorting/Grouping tab: i
e Sort by: Reference Level - ;
0 Check the Footer Checkbox Trun o =] .
0 Select: Title and totals
0 Check the Blank Line Checkbox
e Then Sort by: Type B ey
0 Check the Grand totals Checkbox, e

0 Select: Totals only

0 Uncheck the Itemize every instance
Checkbox

5. Select the Formatting tab:

* Select the field weight_calc and check Calculate totals checkbox

6. Cleanup the schedule for Sheet Placement
* Revise all the Column Title names
e Apply your company view template to the schedule

Stk Poperlics TR0 S aa TREBOPY SOSEDLLE e
Fuekit | Fltes | SemgGrmgg | Feemeli | appesimeis
Fusd
Tree
Fafarusce Lival ek
[T waight_calr
Lot
EETET o
fusichi
1 Horirmatal -
| |
r—
Center =
|
Feh] Larveclom) Fald Farma...
| |
Hiskdim i Cordibaaal Faemel..
i 2 Shom ondibcesl format on sheets
|
o Cancel Halg

& damseding Lemcacing

=

@ tacandng Twmarsing

v maeh e
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Section 6: Tips and Tricks for the Graphical Steel Column Schedule

1. Tag Base Plates in the graphical column schedule.
Since the base plate family has been created using the column template family, base
plates are visible and can be tagged along with the columns in the graphical column

schedule.

K

= N

R

2. Columns offset from gridlines.

The column location of columns that are offset yet still touching the gridline are
actually indicated as centered on the gridline in the graphical column schedule.
In the example below, the centerline of the column is actually 1 ¥2” away from grid
1, but the column location is noted as E-1.

o -1

[ |

L]

WA S

ey~ e | mp——— p———

BF4

WA 0

BF &5

WEdn

pFS

L5

E-119°- 1 142}
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A little opaque text can remedy this issue, but remember to make a note of this
important overridden value in the project team notes in your revit project.

W1ZZ40

BPS

E-1(0-1 12"

3. Base Plate Origins
As mentioned earlier, all base plate families should be created in consideration with
their origin being the centerline of column. This allows you to easily place and align
base plates with the centerline of columns. Ifyou are creating an offset non-
symmetrical base plate identify the origins within the family and add parameters to
flex and offset types accordingly.
In the SE3048-L Base Plate Schedule Project I have added an offset base plate family
to highlight this point. In the clip below, the offset base plate origin has been
assigned and is aligned with the centerline of column as is confirmed by the
graphical column schedule.

W12X40

|
I BP5

[
0-11/2"

E-1(9'- 0 1/2")

However, should we move that base plate even slightly from centerline of column,
we can see that the graphical column schedule will now report the base plate and
column as two separate columns.

W12X40

> o P,

E-1(9'-01/2") | E-1(9'-11/4")
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4. Custom Base Plates and the Resultant Base Plate Schedule
Custom base plate orientations and bolting patterns will require additional
parameters in the families and in the base plate schedule or perhaps just additional
detailing. For our standards I have chosen to go with additional detailing and
added a comment section to the schedule to reference the details. This is one
method to achieve the same result without creating reams of additional base plate
family types. See the clips below.

BASE PLATES,

PLATE WIDTH HOLE | HEIGHT HOLE | A.BOL

MARK | TYPE | WIDTH | HEIGHT | THICKNESS | SPACING SPACING | DIAMET
BP1 RECT 280 280 22 180 180 20
BP2 RECT 300 300 32 200 200 20
BP3 RECT 350 350 38 32
BP4 RECT 125 250 13 50 175 13
BPS L 125 180 13 50 175 13
BP6 RECT 230 500 38 100 125 32
BP7 RECT 230 400 38 130 300 32
BP8 RECT 230 280 22 130 200 20
BP9 L 155 225 22 75 175 13
BP10 RECT 230 500 20 100 125 20

BP11 RECT 230 650 38 100 32

AnA/ Nting o M NALRR

EQ

LENGTH

EQ

LENGTH
oL
[
_‘_$ | ——
|E=py
—
125 150 | 150
LENGTH
§ col
115
L
TEo
—{ —-
— It 8
=
100100} 100|
LENGTH

WIDTH 50, | 50

HOLE

PACING 125 [ 125
1

’ BASE PLATE SCHEDULE
LE A.BOLT ANCHOR ANCHOR ANCHOR PLATE | WEIGHT PER TOTAL
DIAMETER TYPE COUNT EMBED COMMENTS | COUNT PLATE (kg) WEIGHT (kg)
\ 20 ISTAND ARD 4 400 SEE DETAIL 1 10 13.53968 135.3968
] 20 [STANDARD [ 400 SEE DETAIL 1 ] 22608 203472
& 2 [DYWIDAG 5 500 SEE DETAIL 3 3 354175 109 62525
& 13 [KWIK BOLT 4 100 SEE DETAIL 1 5 3.189062 15.945312
> 3 [FWIK BOLT 4 100 SEE DETAIL 6 5 2423687 12.118437
F 2 [DYWIDAG 5 500 SEE DETAIL 4 [ 34.3045 137218
' 32 IDYWIDAG 4 1200 SEE DETAIL 1 8 27 4436 2195488
\ 20 ISTAND ARD 4 400 SEE DETAIL 1 13 11.12188 144 58444
L o 13 [STAND ARD [ 400 SEE DETAIL 6 1 6022913 6022913
‘ 20 ISTAND ARD 6 400 SEE DETAIL 4 4 18.055 7222
" ) ) [DYWIDAG 8 1200 SEE DETAIL 5 2 44 59585 851917
‘)} 1145343653

WIDTH

E0 | E0

g o=y Y
%5 ols TR .
8 z S 1 1 = - =
5 ol qo Lo -+ 2 = 2
=4 3l 41 k} = g - [ =1
* == Zu2 ——
T 25¢ I
WIDTH Elt]
HOLE LENGTH
SPACING
DETAIL 4 DETAILS DETAIL 6
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